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END USER LICENSE
If you are entering into this legal agreement in the UK, or any other country for which a specific agreement is not included in this booklet, 
then the following terms and conditions will apply to you:

This LICENSE (and the terms and conditions contained within it) is a legal agreement between you (the End User) and Global Graphics 
Software Limited, a company incorporated in England with Company No 2049413 with registered office at Barrington Hall, Barrington, 
Cambridge CB2 5RG ("Global Graphics").  This LICENSE sets out the terms upon which Global Graphics and its licensors LICENSEs to the 
End User the Software. The End User must only install and use the Software in accordance with the terms of this LICENSE and the End 
User’s particular attention is drawn to the terms of the LICENSE (Clause 2) (and the restrictions and prohibitions contained within that 
Clause), the limited warranty (Clause 3) and the limitation of liability (Clause 4). 

By installing, loading, copying, storing or otherwise using the Software, the End User agrees to be bound by the terms of this LICENSE. If the 
End User does not wish to be bound by the terms of this LICENSE, the End User should not install, load, copy, store or otherwise use the 
Software, and return the Software or the Documentation for a refund of the Total Charges.

1 INTERPRETATION
1.1 The expressions set out below shall have the meanings in this LICENSE ascribed to below:

Charges mean the fee payable by each End User in accordance with Global Graphics then current price list and Total Charges 
means the total fees payable by all End User’s;

End Users means the individual or company licensed to use the Software under or in respect of this LICENSE as set out in the 
Purchase Order;

Intellectual Property means copyright, domain names, design rights, database rights, semi-conductor topographical rights, 
patents, trade marks (registered or unregistered), service marks, registered designs or any applications thereof, and all other 
intellectual or industrial property rights of a similar nature and Intellectual Property Rights means rights in such intellectual 
property;

Purchase Order means the written or electronic order for the Software submitted by the End User;

Software means the registered version of the Software contained on the disks (CD-ROM(s) or other media) with which this 
LICENSE is provided, together with any changes, modifications, adaptations or alterations thereto together with any subsequent 
versions, releases and corrections and any accompanying documentation.  

2 LICENSE 
2.1 In consideration of the payment by the End User of the Total Charges, Global Graphics grants to the End User, a non exclusive, 

non transferable right to install and use the Software on the terms of this LICENSE.  For the avoidance of doubt, the End User is 
responsible for the installation of the Software and installation must be performed in accordance with the terms of the 
documentation accompanying the Software.

2.2 The End User’s rights and obligations in respect to the use of the Software is as follows:

For a single user LICENSE, the End User may:

2.2.1 install and use the number of copies indicated on the inside cover of the End User License Agreement booklet, provided 
always that only one copy of the Software is used on a single computer subject to both the following conditions being 
satisfied 

(a) End User interaction is required to operate the Software; 

(b) there is a one-to-one (1:1) relationship between the End User and the Software.

For a server based LICENSE, the End User may:

2.2.2 install one copy of the Software on a single file server for use on a local or wide area network, provided that the End User 
must not exceed the total numbers of licensed copies, per server, indicated on the inside cover of this booklet.  For the 
avoidance of doubt, server based Software may only be accessed by users in the same company (or group of companies) as 
listed on the Purchase Order.

2.3 The End user may install an additional copy of the Software on a home or portable computer, provided that the End User is the 
primary user of the computer on which the Software was first installed.  However, the Software on the secondary computer may 
not be used by another person at the same time the Software on the primary computer is being used.

2.4 The End User may make one copy of the Software for archival purposes, provided the archive copy is not installed or used on 
any computer. 

The End User shall not (and shall procure that any third party shall not):

2.5 copy or make derivative works from the Software, except as set out above.  Any copies that you are permitted to make pursuant 
to this LICENSE must contain the same copyright and other proprietary notices that appear on or in the Software.

2.6 sublicense, assign, rent, lease, lend, export or re-export or otherwise market or distribute the Software, or any portion thereof.

2.7 modify, change, alter, adapt, translate, reverse engineer, decompile, disassemble or otherwise attempt to discover the source code 
of the Software, or create derivative works from the Software, except that in the European Community, you may reverse engineer 
only for interoperability purposes and then only if all conditions of Article 6 of Council Directive 91/250/EEC are met.
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2.8 make the Software accessible from the Internet, or other public network, or over a privately operated computer network outside 
of the company listed on the Purchase Order.

3 WARRANTY
3.1 Global Graphics warrants to the End User that the Software will perform substantially in accordance with the documentation 

supplied with the Software for the ninety (90) day period following receipt by the End User of the Software.   To make a warranty 
claim, the End User must return the Software to the location where obtained it together with a copy of proof of purchase within 
such ninety (90) day period. 

3.2 If the Software does not perform substantially in accordance with the documentation supplied with the Software, the entire and 
exclusive liability and remedy shall be limited to either, at Global Graphics option.

3.2.1 the replacement of the Software; or 

3.2.2 the refund of the Total Charges.

3.3 The warranty set out in this Clause 3.1, and the entire and exclusive liability and remedy set out in Clause 3.2 states the sole and 
exclusive obligation of Global Graphics to the End User and sets out the entire remedies which Global Graphics and/or its 
licensors have to the End User for breach of this warranty. 

4 LIMITATION OF LIABILITY
4.1 Neither party excludes or limits liability to the other party for death or personal injury caused by negligence or for fraud or 

fraudulent misrepresentation nor where liability cannot be excluded or limited as a matter of law (e.g. breach of any obligations 
implied by Section 12 of the Sale of Goods Act 1979 (as amended) or Section 2 of the Supply of Goods and Services Act 1982).

4.2 Subject to the provision of Clause 3.1 and 4.1, all representations, warranties, conditions whether implied by statute or otherwise 
are excluded from this LICENSE. In the case of representations, warranties, conditions implied by statute these are excluded to 
the fullest extent permitted by law. [In particular, Global Graphics and its licensors are not aware of the purposes for which the 
End User is to use the Software make no warranties, express or implied, as to the Software’s fitness for any particular purpose.]

4.3 The End Users attention is also drawn to the following and subject always to the provisions of Clauses 3.1 and 4.1, Global 
Graphics and its licensors:

4.3.1 do not and cannot warrant that the Software is free from minor errors not materially affecting the performance or 
functionality of the Software;

4.3.2 do not and cannot warrant that the Software is and will be free from viruses (including, but not limited to, hidden routines, 
worms, logic or time bombs, disabling or disruptive codes or routines, expiration dates and software switches).  However, 
whilst Global Graphics has used reasonable endeavours and taken all reasonable steps to check the same, the End User is 
solely responsible for performing virus and other checks on the Software;

4.3.3 are not and shall not be liable for any failure or malfunction resulting wholly or to any material extent from the negligence, 
operator error, any other misuse or abuse of the Software;

4.3.4 are not and shall not be liable for any failure to comply with the terms of this LICENSE including but not limited to, the 
decompilation, transfer, disassembly, reverse engineering, modification, alteration or adaptation of the Software or its 
merger with any other program or any maintenance repair adjustment alteration or enhancement of the Software by any 
person other than Global Graphics;

4.3.5 are not and shall not be liable for any failure by the End User to implement recommendations advised by Global Graphics 
in respect of, or solutions for faults in, the Software.

4.4 Subject always to the provisions of Clause 4.1, the aggregate liability of Global Graphics under this LICENSE (without prejudice
to any non-financial remedies), in contract, tort, misrepresentation or otherwise shall be limited to the Total Charges.

4.5 For the avoidance of doubt, Global Graphics shall not have any liability to the End User for any:

4.5.1 loss of profit, loss of use, loss of savings, goodwill or business interruption; or,

4.5.2 indirect, economic, consequential, special or financial loss or damage; or

4.5.3 loss of data.

5 INTELLECTUAL PROPERTY, OWNERSHIP AND RISK
5.1 The Software is and remains the property of Global Graphics and/or its licensors and is protected by amongst other things by 

copyright law.  All right, title to, ownership of and all Intellectual Property Rights and all other proprietary rights in the Software 
belong to and shall belong to, vest in and shall remain vested in Global Graphics (and its licensors as the case may be). 

5.2 In addition, and for the avoidance of doubt, the End User shall have no right to use Global Graphics or its licensor’s trademarks 
with its promotion or publication of the Software, without Global Graphics written approval.

5.3 The End User shall not remove any product identification, copyright notices, trade marks or other legends set forth on the 
Software and shall reproduce all such notices on any copies. 

5.4 Risk in the Software passes to the End User on delivery.
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6 CONFIDENTIALITY 
6.1 The Software is owned by Global Graphics and its licensor(s) and is protected by copyright law, trade secret law, and as 

otherwise set forth in this LICENSE. 

6.2 The End User agrees not to disclose or make available the Software, or any portion or copy thereof, or the results of any 
benchmark tests using the Software, to any third party without Global Graphics prior written consent.

7 TERMINATION
7.1 Global Graphics may terminate this LICENSE immediately as notice if you fail to comply with any of the terms and conditions of 

this Agreement.  Upon termination, the End User shall cease using the Software and shall remove the Software from any 
personal computer or server and destroy all copies of the Software. Termination of this Agreement shall be without prejudice to 
the other rights and remedies of the either party. 

7.2 The provisions of Clauses 4,5 and 6 shall survive the termination of this Agreement as shall any provisions which are expressed,
or by implication are intended, to survive termination of this Agreement. 

8 GENERAL
8.1 This LICENSE shall be governed in all respects by English Law and subject to the non-exclusive jurisdiction of the English 

Courts.

8.2 This LICENSE is personal to the Global Graphics and the End User. Neither party shall assign, novate, sub-contract or otherwise 
dispose of all or any part thereof without the previous consent in writing of the other party.

8.3 No variation of this LICENSE shall be binding upon the parties unless the same shall be in writing duly signed by a director on 
its behalf and such variation shall be peculiar to the circumstances mentioned by such writing and shall not be regarded as a 
general variation. The failure of either party to insist upon strict performance of any provision of this LICENSE, or the failure of 
either party to exercise any right or remedy to which it is entitled hereunder, shall not constitute a waiver thereof and shall not 
cause a diminution of the obligations established by this LICENSE.

8.4 Except as otherwise expressly provided no LICENSE communication from one party to the other shall have any validity under 
this LICENSE unless made in writing by or on behalf of either party. Any notice or other communication whatsoever which is 
required or authorised by this LICENSE to give or make to the other, shall be served by e-mail, facsimile or post in a prepaid first 
class letter, addressed to Global Graphics at the registered office set out in the pre amble to this LICENSE.  If any notice or other 
communication is sent by e-mail, the sender shall confirm the communication by way of a letter sent by first class post. Any 
letters sent by first class post which is not returned as being undelivered that notice or communication shall be deemed for the
purposes of this LICENSE to have been given or made on the second day after posting. Any notice served by facsimile or telex 
shall be considered to have been delivered when actually received by the recipient.

8.5 This LICENSE together with the Schedule to it, represents the entire agreement between the parties and supersedes all prior 
agreements, arrangements and understanding between the parties to that subject matter.

8.6 Pursuant to section 1(2) of the Contracts (Rights of Third Parties) Act 1999, the parties intend that no term of this LICENSE may 
be enforced by a person who is not a party to this LICENSE but this does not affect any right or remedy of a third party which 
exists or is available apart from under that act.

8.7 If any provision of this Agreement is held invalid, illegal or unenforceable for any reason by any court of competent jurisdiction, 
such provision shall be severed and the remainder of the provisions hereof shall continue in full force and effect as if this 
LICENSE had been executed with the invalid, illegal or unenforceable provision eliminated. 

9 U.S. GOVERNMENT SUPPLY 
9.1 This Jaws PDF Creator Software is a commercial computer software program developed at private expense and is subject to the 

following Restricted Rights Legend: "Use, duplication, or disclosure by the United States Government is subject to restrictions as 
set forth in (i) FAR 52.227-14 Alt III, (ii) FAR 52.227-19; as applicable.  Use by agencies of the Department of Defence (DOD) is 
subject to Global Graphics customary commercial license as contained in the accompanying license agreement, in accordance 
with DFAR 227.7202-1 (a).  For purposes of the FAR, the Software shall be deemed ’unpublished’ and licensed with disclosure 
prohibitions, rights reserved under the copyright laws of the United States. 
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10 CONTACT INFORMATION
10.1 Help and assistance together with detail of support and maintenance are available on the website details of which are set out in

the documentation accompanying the Software. The End User should wherever possible seek help and assistance from and 
contact Global Graphics via the website, however any written communications should be sent to the registered office, details of 
which are set out in the pre amble to this LICENSE. If sending mail, or leaving bug reports on the web server, please remember to 
include at least your email address so that we can reply to you.

Europe:

Global Graphics Software Limited
Barrington Hall
Barrington
Cambridge, CB2 5RG 
UK

telephone +44 1223 873 800
fax +44 1223 873 873

United States:

Global Graphics Software, Inc.
5875 Trinity Parkway
Suite 110
Centreville, VA 20120
USA

telephone +1 703 266 9588
fax +1 703 266 9582

Web: www.jawspdf.com

E-mail: sales@jawspdf.com
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0Jaws PDF Creator on 
Macintosh platforms
1  Introduction
Jaws PDF Creator converts PostScript language files into PDF files (Portable 
Document Format). These files can subsequently be used with PDF viewing 
and editing applications such as Jaws PDF Editor™ and Adobe® Acrobat®

products, plus any other third-party PDF tools. The PDF files produced by 
PDF Creator are fully compliant with the PDF 1.3 and 1.4 specifications pub-
lished by Adobe.

PDF Creator has two modes of operation:

Embedded mode

The application is embedded into the printing system of your com-
puter’s operating system (OS) so that it appears as a PostScript compati-
ble printer to applications running on that computer. You can produce a 
PDF file from any document by printing the document to the Jaws PDF 
Creator printer, in the same way that you would produce hard-copy by 
printing to a real printer.

When creating PDF files, the printing system produces an intermediate 
PostScript language form of your document, which PDF Creator imme-
diately converts to PDF and writes to disk. 
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Jaws PDF Creator works with PostScript printer drivers from Apple and 
Adobe.

Because PDF Creator is integrated into the printing system, it has no 
user interface of its own. However, it does have a Control Panel (known 
as the Config Editor on Mac OS X platforms) which allows you to config-
ure various parameters affecting the final PDF output.

Standalone mode

A standalone version of Jaws PDF Creator, called Jaws ToPDF takes an 
existing PostScript language file—either a legacy file or a file produced 
on another computer—and converts it to PDF.

1.1  About this manual

This manual is intended as a guide to the installation and use of PDF Creator.

• Section 2 describes how to install, upgrade and uninstall PDF Creator.

• Section 3 covers basic use of both the Jaws PDF Creator printer and the 
Jaws ToPDF application.

• Section 4 describes the Jaws ToPDF application in more detail.

• Section 5 provides a comprehensive reference for the PDF Creator 
Config Editor (OS X)/Control Panel (OS 9). This is where most of the 
configuration is done.

• Section 6 is where you will find all the support information you may 
require, such as how to register your copy and download new versions.

• Appendix A, “Technical Information” contains technical and more 
advanced information about PDF Creator as well as a map of all the 
installed files.

Throughout this manual, references to PDF viewer or PDF viewing application
should be understood to refer to Jaws PDF Editor™, Acrobat Reader™ and 
Acrobat®.
Jaws PDF Creator Edition 3: July 2003



1 Introduction
This manual describes Jaws PDF Creator operation on both Mac OS X and 
Mac OS 9.x platforms. Differences in operation, or features are indicated by 
using different headings or separate paragraphs. In particular, details for Mac 
OS X versions are prefixed with the Mac OS X: heading. Details for Mac OS 
9.x versions are prefixed with the Classic Mac: heading.

1.2  System Requirements

The system requirements are:

• Mac OS X: 10.2.3 or later.

• Classic Mac: Mac OS 9.x.

• At least 10 MB of free disk space. 

• Memory requirement is heavily dependent on the nature of the docu-
ment being converted into a PDF file.
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2  Installing and uninstalling PDF Creator

2.1  Installation

PDF Creator can be installed on Mac OS X platforms or Classic Macintosh 
platforms running Mac OS 9.x.

To install PDF Creator on a Macintosh platform:

1. Temporarily disable any virus detection software.

2. Double-click the installer application that appears on your desktop 
when you insert the CD-ROM into the drive. 

3. Follow the on-screen instructions to install Jaws PDF Creator.

Note that on Mac OS X, you will be prompted for a password when you 
run the installer. This is because the installer requires administrator 
privileges.

During installation, you can either enter a serial number or run in evaluation 
mode, as described in Section 2.2 below.

2.2  Serial number

If you have a serial number for your version of Jaws PDF Creator you can use 
it at installation time. This will immediately give you a licensed and fully fea-
tured version of the application.

If however you wish to evaluate the product, you can install it without a serial 
number. To do this, click the Evaluation button. 

This will provide you with a working copy of the application. In this case, all 
PDF files generated by the application will contain a watermark on every 
page.

2.3  Upgrade from evaluation to a fully working version

When you have evaluated Jaws PDF Creator you may wish to upgrade to a 
fully working version. 

Mac OS X: Open the Jaws ToPDF application and choose the Jaws 
ToPDF > About Jaws ToPDF menu option.
Jaws PDF Creator Edition 3: July 2003



2 Installing and uninstalling PDF Creator
Classic Mac: Open the Jaws ToPDF application and select About Jaws 
ToPDF from the Apple menu.

The About dialog will appear. If you do not have a valid serial number, select 
the link to the Jaws web site (www.jawspdf.com) and go to the How to buy
page and follow the instructions.

When you have your serial number you can upgrade your version of Jaws 
PDF Creator. 

Mac OS X: Click the Enter Serial Number option in the About Jaws PDF 
Creator dialog box.

Classic Mac: Open the Jaws ToPDF application and select Enter Serial 
Number from the Apple menu.

The following dialog will appear:

Figure 2.1  Serial number dialog box

Enter your name, company and serial number and select Done or OK.
Edition 3: July 2003 Jaws PDF Creator 5
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The user name must consist of at least two characters. The company name is 
optional.

Your version of PDF Creator will become licensed and fully functional.

If required, you can amend an existing serial number or even remove it and 
revert to an evaluation copy (possibly required if you want to check out the 
facilities of a new version).

2.4  Uninstall PDF Creator

To remove PDF Creator from a Macintosh computer:

1. Double-click the install application and click Continue in the splash 
screen.

2. In the End User LICENSE Agreement dialog box click Accept to display 
the installer's main window.

3. Select Uninstall from the menu at the top left of the window and click the 
Uninstall button.

4. On Classic Macintosh platforms, once the removal has completed, drag 
the PDF Creator Desktop Printer icon to the Trash.
Jaws PDF Creator Edition 3: July 2003



3 Getting started with PDF Creator
3  Getting started with PDF Creator
This section describes the main features of PDF Creator and how to use them.

3.1  Create a PDF file from an application

To create a PDF file directly from an application, print the document in the 
normal way, ensuring that you select Jaws PDF Creator as the printer:

Mac OS X: Choose Jaws PDF Creator as the Printer and select the 
required configuration and PDF file name in the Jaws PDF Creator pane 
before clicking Print.

Do not click the Save As PDF button and do not select Save as File in the 
Output Options pane.
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Figure 3.2  Print dialog

Classic Mac: When the Print button is clicked in the Print dialog a Save 
dialog appears allowing you to choose the location and name of the PDF 
file. Clicking Save completes the process.

Do not select the File option from the Destination menu. PDF Creator 
always prints to a PDF file. If you select this option you will create a 
PostScript file instead.

3.2  Convert a PostScript or Encapsulated PostScript file to PDF

Jaws PDF Creator can convert PostScript language or EPS (Encapsulated 
PostScript) files to PDF.

When Jaws PDF Creator is installed, a desktop icon called Jaws ToPDF is 
created. 

Mac OS X: Drag the PostScript or EPS file onto the Jaws ToPDF 
application. Alternatively, select the document in the Finder, control-
click to open the contextual menu and select Open with > ToPDF.

Classic Mac: Drag the PostScript or EPS file onto the Jaws ToPDF 
application. Alternatively, select the document in the Finder, control-
click to open the contextual menu and select Convert To PDF.
Jaws PDF Creator Edition 3: July 2003



3 Getting started with PDF Creator
The location of the PDF file is the same folder as the source document, 
although this location can be changed, see Section 5.3 for details. The progress 
of the PDF file creation is indicated by a progress dialog. 

3.3  Create a PDF file containing bookmarks and links

PDF Creator includes an implementation of the PostScript pdfmark operator, 
which is used to create PDF annotations. Some applications, such as 
FrameMaker®, directly support the generation of PDF annotations. Others 
may require the use of special macro packages or hand-made EPS files. In each 
case, any method of generating annotations that works with other PDF cre-
ation applications also works with PDF Creator.

The pdfmark operator is documented in Adobe Technical Note number 5150, 
which is freely available from their web site.

3.4  Create a PDF file using a custom page size

If you are generating a PDF file intended mainly for on-screen viewing, you 
may want to generate it with an unusual page size, so that it fits more neatly 
onto the screen. The PostScript compatible interpreter in PDF Creator can 
accept any page size specified via the setpagedevice operator.

Mac OS X: To use a custom page size, choose Custom Paper Size from 
the Settings menu in the Page Setup dialog. You must specify a name for 
the paper size as well as the dimensions. Ensure this paper size is 
selected when printing to Jaws PDF Creator. For full details, see the 
Printing using a custom paper size Mac Help procedure.

Classic Mac: To use a custom page, choose Custom Page Sizes from the 
LaserWriter 8 Page Setup dialog that appears when you choose Page 
Setup... from any application.

3.5  Change the name or destination folder of the PDF file

When you print to PDF Creator from an application, PDF Creator prompts 
you for a destination folder for the output file, unless you enable the Always 
output files to option in the General tab. The default destination folder is the 
Edition 3: July 2003 Jaws PDF Creator 9



Jaws PDF Creator on Macintosh platforms

10
last folder you used, and the file name is constructed from the document 
name provided by the application. You may change either of these before 
clicking OK to save the PDF output file.

Jaws ToPDF does not prompt you for the output file name, by default. Instead, 
the output file is created in the same folder as the input file, and with the same 
name, except for a .pdf extension. If you enable the Always output files to 
option in the General tab, Jaws ToPDF places the file in this folder, but with 
the same name as the input file (and a .pdf extension).

Note that the output files are saved as a PDF file type.

On Classic Macintosh platforms, if you select Always prompt for a destination in 
the Configure Jaws PDF Creator dialog box, a prompt for an output file name 
appears for each file. See Section 4.2 for more information about configuring 
the Jaws ToPDF application. 

When the prompt for a name and destination folder appears you can also 
change the security options. For more information, see Section 5.6.

3.6  Stop PDF Creator prompting for a file name

In the PDF Creator Config Editor/Control Panel, click the General tab and 
select the Always output files to check box. Then select the folder in which you 
want to save the PDF files. For more information, see Section 5.3.

3.7  Turn off warning for non-DSC PostScript

On Classic Macintosh platforms, you are able to turn off warnings when PDF 
Creator encounters non-DSC PostScript language files. For more information 
see Section 4.2.

3.8  Produce PDF files compatible with PDF viewing applications

Jaws PDF Creator can produce PDF version 1.3 and 1.4 files.

PDF 1.3 and 1.4 files are compatible with Jaws PDF Editor (although PDF 
Editor cannot currently open PDF 1.4 files using 128 bit encryption).

PDF 1.3 files are compatible with Acrobat v4.0 (or later). PDF 1.4 files are com-
patible with Acrobat v5.0 (or later).
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3 Getting started with PDF Creator
Note: The PDF 1.4 files produced by PDF Creator comply with the Adobe 
specification, but do not support all PDF 1.4 features.

3.9  Produce files that can be sent by e-mail

To produce files that can more easily be sent by e-mail, select the General tab
in the PDF Creator Config Editor/Control Panel and select the ASCII format
check box. For more information, see Section 5.3.

3.10  Produce more compact PDF files

There are several options that have an effect on the size of the output file, all of 
which are available in the Font embedding tab and the Compression tab of the 
PDF Creator Config Editor/Control Panel. The default settings after installa-
tion are designed to give the maximum lossless compression for general use. 
The most important options are:

Compress text

This option applies zip compression to the PDF commands in page 
descriptions.

Subset embedded fonts

This option can help reduce the size of the output. If you are working in 
a controlled environment, where you know which fonts are loaded on 
the destination machines, choosing not to embed some or all fonts can 
further reduce the size.

Image compression

Zip compression is usually the best overall compromise setting as it is 
efficient and lossless.

JPEG compression

If you can tolerate lossy compression, that is, compression that throws 
some of the data away never to be retrieved, you can use JPEG 
compression.
Edition 3: July 2003 Jaws PDF Creator 11



Jaws PDF Creator on Macintosh platforms

12
Advanced users can also tailor the parameters used by JPEG 
compression.

These parameters are in the file startup.ps. See Section A.2.4 on 
page 60 for further details.

Zip with Predictor

You may find that Predictor compression sometimes improves the per-
formance on images where there are lots of similarly colored pixels.

Note: The terms Zip and Flate are interchangeable; they both refer to the 
same kind of compression.

3.11  Launch PDF application to view the file when complete

Jaws PDF Creator can automatically launch any application on successful 
completion of a job. For details on how to set the Launch application on job 
completion option, see Section 5.3.

3.12  Change the author name in the PDF file

The author name is the name that appears in your PDF viewer if you select 
File > Document Info > General info. The author name that PDF Creator places in 
the Info dictionary of a PDF file is a combination of the current user name and 
the computer name. If the computer is not on a network, PDF Creator uses the 
name and company you entered during installation. See Section A.2.4.2 for 
more information.

Note that it is possible to change this by editing the file prologue.ps. See 
Section A.2.4 on page 60 for further details.

If you edit this file with a text editor, you will see the following lines:
%%%%%
% Here's how to change the Creator in the DocInfo structure. 
% Watch the ':' !
% (: YourNameHere) DoAuthor

Change YourNameHere to the text you would like, and remove the % from the 
beginning of the line. PDF Creator uses this for the author name.
Jaws PDF Creator Edition 3: July 2003



4 Jaws ToPDF—converting files to PDF
4  Jaws ToPDF—converting files to PDF
Jaws ToPDF is a front end to PDF Creator that lets you treat it as a standalone 
application which allows you to convert existing PostScript language or EPS 
files to PDF. 

Jaws ToPDF can accept PostScript language and EPS files including EPS with 
previews. If Jaws ToPDF does not recognize a file format, it generates a warn-
ing before processing.

4.1  Using Jaws ToPDF

You can use the Jaws ToPDF application to convert a file to PDF, in one of the 
following ways:

• Drop a file onto the Jaws ToPDF application icon.

• Choose Open... from the File menu.

• Drop a file onto the Jaws ToPDF application window.

When a file is being converted its progress is indicated:
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Figure 4.3  Jaws ToPDF application window

The PDF file is saved in the default output folder, which is the same location 
as the input file, unless the Always Output Files To option has been set in the 
General tab.

Note: If the destination file name already exists in this location, and the 
Overwrite an existing PDF file option is not selected in the General tab, a unique 
number is appended to the file name. An example of a name is: Book.pdf, 
Book 1.pdf, Book 2.pdf.

See Section 5.3 for more information.

4.2  Jaws ToPDF configuration

Open the Config Editor (Mac OS X) or the Jaws ToPDF Settings dialog box 
(Classic Macintosh) as follows:

Mac OS X: Click the Edit button in the Jaws ToPDF application window 
to open the Config Editor.

Classic Mac: With the Jaws ToPDF application open, use the Settings > 
Configure... option to open the Jaws ToPDF Settings dialog box.
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Figure 4.4  Jaws ToPDF configuration

Three standard configurations are provided from the Configuration menu:

Press Ready

Optimized for sending jobs to a commercial printer at 2540 dpi (dots per 
inch).

Print Quality

Optimized for printing to office type laser printers at 600 dpi.

Web

Optimized for screen viewing and for use in web pages at 72 dpi.

Any custom configurations you have created also appear in this menu. Note 
that you cannot edit the standard configurations. On Mac OS X platforms, the 
names of shared configurations are enclosed in brackets. For example,
(my_conf). See Section 5.1.1 and Section 5.1.2 for details.

Mac OS X: You can use the Create, Rename and Remove buttons in the 
Config Editor to create, modify and remove configurations. See 
Section 5.1 on page 20 for more details.

Classic Mac: Use the Open Control Panel button to display the PDF 
Creator Control Panel, where additional configurations can be defined. 
For more information on how to create a custom configuration see 
Section 5.2.
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In the Jaws ToPDF Settings dialog box (Classic Mac only), Jaws ToPDF can be 
configured to either; prompt for an output file name, or to save the file in the 
default output folder.

When you select Always prompt for a destination, a PDF Creator browser dialog 
is displayed every time you convert a file. This allows you to change the 
output file name or place it in a different folder. 

If you select Do not prompt for a destination, Jaws ToPDF silently outputs the 
PDF file to the default output folder. Although you can only change this set-
ting from the Jaws ToPDF application window, it also affects any jobs which 
are converted by being dropped onto the desktop icon or shortcut.

Whether or not you ask Jaws ToPDF to prompt for a destination, it calculates 
the default output folder in the same way. This is the same folder as the input 
file, unless you have set the Always output files to option in the General tab, in 
which case it is the folder you have specified. See Section 5.3 for more infor-
mation about the General tab. If you have configured Jaws ToPDF not to 
prompt for a destination, the default output folder is used. If you have asked 
Jaws ToPDF to prompt you, the browser dialog still allows you to change the 
output folder.

Standard PostScript language files begin with the comment %!PS. If this com-
ment is missing, PDF Creator is still able to recognize the file as a PostScript 
language file and process it in the normal way. On Classic Macintosh 
platforms, with the Warn for non-DSC Standard PostScript option checked (as it 
is by default), any PostScript language file encountered without a %!PS com-
ment will cause an error message to be displayed. You then have the choice 
whether to continue to process the file or not.

When you convert an EPS file, Jaws ToPDF uses the bounding box in the file to 
determine the page size for the PDF file, and ignores the currently selected 
Use %%BoundingBox for option. See Section 5.3.1 for more information.

When the configuration for the Jaws ToPDF application is completed, select 
OK. Selecting Cancel aborts the changes made to the configuration.
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5  Config Editor reference
This section describes all the options available in the Config Editor.

Note: The Config Editor is known as a Control Panel on Classic Mac 
platforms.
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Figure 5.5  Config Editor/Control Panel

Use the following options to open the Config Editor/Control Panel:

Mac OS X: Click Edit in the ToPDF application window, or open the 
Config Editor application, located by default in the Applications folder.

Classic Mac: Select Apple Menu > Control Panels > Jaws PDF Creator. 
Alternatively, with the Jaws ToPDF application open, use the Settings > 
Configure... option and then click the Open Control Panel button.

Mac OS X versions of the Config Editor contain buttons that allow you to 
create, modify and remove configurations, as described in Section 5.1. In 
Classic Macintosh versions of PDF Creator, equivalent controls are located in 
the Settings tab within the Control Panel.

The PDF Creator Config Editor/Control Panel has a number of tabs for differ-
ent tasks. Click the various tabs to access and change the information con-
tained under that heading. Section 5.2 through to Section 5.8 describe the 
options contained within each tab. 
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5.1  Managing configurations on Mac OS X platforms

You can use the Create, Rename and Remove buttons in the Config Editor to 
add, modify and delete configurations.

5.1.1  Creating a new configuration (Mac OS X)

Click the Create button in the Config Editor to open the Add Configuration 
dialog box, which allows you to create a custom configuration.

You must provide a unique name for the configuration in the Configuration
text box. Optionally, you can provide a Description of the configuration, such 
as its intended use.

If you wish to duplicate the settings from another configuration, you should 
choose it from the Based On menu.

If you have administrator privileges, you can click the Make available to all 
users check box if you wish to allow other users to access the configuration. 
Otherwise, this option is disabled. Note that only administrators can edit or 
delete shared configurations. The names of shared configurations are auto-
matically enclosed in brackets. For example, my_conf becomes (my_conf) and 
(my_conf) becomes ((my_conf)).

5.1.2  Renaming a configuration (Mac OS X)

Click the Rename button in the Config Editor to open the Rename 
Configuration dialog box, which allows you to change the name of the cur-
rently selected configuration. 

Check the Current name details to ensure that you are renaming the correct 
configuration. You must enter a unique name for the configuration in the New 
name text box.

Note: If you have administrator privileges, you can make an existing configu-
ration available to all users by clicking the Make available to all users check box. 
The names of shared configurations are automatically enclosed in brackets.
For example, my_conf becomes (my_conf) and (my_conf) becomes 
((my_conf)).
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5.1.3  Deleting a configuration (Mac OS X)

Click the Remove button in the Config Editor to delete the currently selected 
configuration. Note that you cannot delete any of the predefined configura-
tions (Web, Press Ready, Print Quality). 

You cannot delete configurations created by other users, unless you have 
administrator privileges.

5.2  Settings tab (Classic Mac only)

Note: On Mac OS X platforms, the controls described below are located at the 
top of the Config Editor, rather than within a tab. See Section 5.1 on page 20 
for more details.

Typically, the options in this tab are the most frequently changed. You can 
choose the default configuration that PDF Creator will use to create PDF files. 

Figure 5.6  Settings tab

The menu in the Current Configuration section contains the name of the default 
configuration. If you want to use a different configuration, choose another 
name from the menu. This new selection is immediately available (you do not 
have to close the dialog).
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PDF Creator is supplied with three standard configurations that are suitable 
for most uses:

Press Ready

Optimized for sending jobs to a commercial printer at 2540 dpi (dots per 
inch).

Print Quality

Optimized for printing to office type laser printers at 600 dpi.

Web

Optimized for screen viewing and for use in web pages at 72 dpi.

Note that you cannot edit the standard configurations. As each option is 
selected, the window below contains a brief description of that option. 

5.2.1  Creating a new configuration (Classic Mac)

If none of the existing configurations in the Settings tab (Classic Mac only) are 
appropriate, you may create a new one.

Select the configuration which most closely matches your intended new con-
figuration and click Duplicate.

Although a unique name for the configuration is generated automatically, you 
may want to change the name and description to reflect the intended use.

5.2.2  Editing a configuration (Classic Mac)

If you want to make changes to an existing configuration in the Settings tab 
(Classic Mac only), other than one of the standard configurations, select it 
from the Current Configuration menu then make the desired changes to the 
other tabs.

New options are immediately available (you do not have to close the dialog). 
To abort recent changes use the Edit > Undo menu option.
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5.2.3  Renaming or removing a configuration (Classic Mac)

You may change the name or description of an existing configuration in the 
Settings tab (Classic Mac only) by selecting it and clicking the Rename button. 
You may remove a configuration by selecting it from the list and clicking the 
Remove button. 

The standard configurations that are shipped with PDF Creator may not be 
renamed or removed, therefore these buttons are disabled when a standard 
configuration is selected from the menu. If you do make changes to a standard 
configuration, you are prompted to save the modified configuration with a 
new name.

Leading and trailing spaces are removed from the name. Configuration names 
must be unique and are not case sensitive (that is, ConfigName and configNAME
are considered to be the same).
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5.3  General tab

The General tab provides options to configure the type of PDF file, the loca-
tion for the file and the actions to perform when the PDF has been created.
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Figure 5.7  General tab

The following items in the File Options section of the General tab, allow you to 
control the format of the output file:

PDF file format

Use this option to create either PDF 1.3 or PDF 1.4 files.

All PDF 1.3 and 1.4 are compatible with Jaws PDF Editor.

PDF 1.3 files are compatible with Acrobat Reader v4.0. PDF 1.3 and PDF 
1.4 files are compatible with Acrobat Reader v5.0.

Note: PDF Creator v3.0 or later does not create PDF 1.2 files.

Thumbnail generation

Jaws PDF Creator can optionally generate thumbnail images of each 
page (either monochrome or color), which can be used as a navigation 
aid in your PDF viewing application. Some PDF viewers automatically 
create thumbnails so leaving this option set to off can reduce the size of 
the generated PDF.
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Resolution

This option allows you to change the effective resolution at which the 
PostScript language job is rendered.This only affects jobs which contain 
resolution-dependent (and therefore device-dependent) code. If your job 
contains pattern fills, the printer driver attempts to snap the pattern fre-
quency to a sub-multiple of the device resolution. Some drawing pack-
ages also use the resolution (in conjunction with the halftone frequency) 
to calculate the number of steps to use for graduated fills. All other page 
elements should be unaffected by the resolution.

If the PDF file is intended for printing, you should set the resolution to 
be the same as the resolution of the intended final output device. 
Otherwise, you should only change the resolution if you experience 
poor quality output with pages containing patterns or graduated fills.

ASCII format

If this option is selected, any binary data (including compressed text) in 
the PDF file is converted to a printable ASCII representation. This makes 
it safe to transmit your PDF pages over a medium that does not support 
binary transmission (internet e-mail for example). Using ASCII format 
will increase the size of your PDF file.

Auto-rotate pages

PDF Creator will always honor requests for landscape output, however 
some applications will produce landscape output by rotating the output 
onto a portrait page. When printed, this is not a problem, as the page can 
easily be rotated. However, when producing a PDF this leads to text run-
ning up the screen.

If this option is selected, PDF Creator will look for, and act on, the 
%%ViewingOrientation DSC comment in the incoming PostScript job. 
The %%ViewingOrientation comment explicitly specifies how to rotate 
the page from its default orientation so that the PDF is produced at its 
optimum viewing orientation.

The %%ViewingOrientation DSC comment is inserted into the job by the 
application generating the PostScript files and/or the printer driver. Not 
all applications and drivers generate this comment. 
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If the %%ViewingOrientation DSC comment is present in a job, it will be 
used. Otherwise PDF Creator will attempt to determine the orientation 
of the majority of the text on the page, and rotate the page until this text 
is upright.

PDF Creator does this by looking at the text baseline and making it 
travel from left to right, so it gets the result wrong if most or all of the 
text on the page is mirrored. 

For more information on rotation, see “Troubleshooting” on page 51.

Optimize for fast web viewing

Before distributing PDF files via the web you should make sure they are 
created using this option. 

This option may reduce file size, and prepares the document for page-at-
a-time downloading, sometimes called byte-serving. You will generally 
find that this option significantly reduces the file size of your PDF 
document.

When a document has been optimized for page-at-a-time downloading, 
the web server sends each individual page of information requested by 
the user, rather than the whole PDF document. When working with 
large documents, which can take a long time to download, using the 
Optimize for fast web viewing option is particularly important.

The following items in the Output Options section of the General tab, allow you 
to control what happens to the PDF once it has been created:

Always output files to

If this box is checked, PDF Creator does not prompt you for a destination 
file name, but outputs all PDF files to the specified destination folder. 
The file name is composed of the document name (with a numerical 
suffix, if necessary to avoid duplicate file names). This feature is mainly 
of use when using PDF Creator to generate all files in a single location. 
In this case, you should also make sure that you do not have Display 
Messages enabled in the Reporting tab, described in Section 5.8.

Note: The numeric suffix generation can be defeated using the Overwrite 
an existing PDF file option. See later in this section for more information.
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Mac OS X: Select the check box, then either enter the full path or click 
Choose to select the required folder.

Classic Mac: When you select this option a Select Folder dialog box 
appears allowing you to choose the required folder. If a folder has previ-
ously been selected, use the Change button to choose a new location.

Launch on job completion

You can select an application, which PDF Creator executes each time a 
job is successfully converted to PDF. 

Mac OS X: Select the check box, then either enter the full path or click 
Choose to select the required application.

Classic Mac: When you select this check box, a Choose Folder dialog box 
appears allowing you to select the required application. PDF Creator 
sends the nominated application an Open Document AppleEvent. If the 
application is not already running, it will be launched. Within the Jaws 
PDF Creator:Scripts folder two scripts are available for selection. The 
scripts Create Eudora Message and Create Outlook Message open the 
respective applications with the previously generated PDF selected as an 
attachment.

View the PDF file after creation

Select this option to automatically open your generated PDF file using 
the system-registered PDF viewing application. If a viewing application 
is not installed, nothing will happen.

Overwrite an existing PDF file

With this option selected, PDF files with the same name as an existing 
file overwrite the existing file rather than create a file name with an 
increment. This option only applies when the Do not prompt for a 
destination option is selected. If Always prompt for a destination is selected 
you always have the choice of overwriting or creating a new name.

Advanced (Classic Mac only) 

Click the Advanced button in the General tab to open the Advanced 
Options dialog box and access extra configuration options.
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5.3.1  Advanced Options dialog box

Note: On Classic Macintosh platforms, advanced options are accessed by 
clicking Advanced in the General tab to open the Advanced Options dialog 
box. The options in this dialog box as the same as those in the Advanced tab of 
PDF Creator on Mac OS X platforms. See Section 5.7 for a description of 
advanced options.

5.4  Compression tab

The sections in the Compression tab allow different compression techniques 
to be applied to different types of images.
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Figure 5.8  Compression tab

Downsample

These options allow you to control whether and how PDF Creator 
reduces the resolution of images in the PostScript language file input.

Set this to 'Don’t downsample' if your documents are intended for 
printing.

'Subsample' reduces the resolution of the image by dropping pixels.

'Average' reduces the size by averaging neighboring pixels and produces 
good quality results. You cannot average a monochrome image in PDF 
Creator because PDF Creator does not “promote” such images to 
grayscale.

'Bicubic' reduces the resolution by performing bicubic interpolation to 
generate new pixel values. This option can generate more pleasing 
results though the PDF will be slower to generate. Bicubic is not avail-
able with monochrome images.
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Compression

There are three compression filters available for dealing with images.

The Zip filter uses a lossless compression technique and normally pro-
duces good compression ratios. It can optionally apply a predictor algo-
rithm which can further improve the compression for some classes of 
image.

The JPEG filter uses a lossy algorithm (which irretrievably discards 
data), but it produces excellent compression ratios on photographic 
images. You can optionally modify some of the JPEG compression 
parameters by editing the file startup.ps, as described in 
Section A.2.4.1. 

The CCITT filter uses standard fax compression, and is only applicable 
to bitmap images. You can control the selection of group 3 or group 4 fax 
compression in startup.ps. See Section A.2.4.1 for details.

Resolution

If you have enabled downsampling, this option lets you specify the 
target resolution of the reduced images actually embedded in the PDF 
file.

Compress text

If this is selected, PDF Creator compresses textual information, such as 
page descriptions, using Zip compression.
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5.5  Font embedding tab

The Font embedding tab allows you to control how fonts are handled in your 
PDF files.
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Figure 5.9  Font embedding tab

Always embed

Fonts listed in this box are always embedded in the output PDF file. Use 
the Add and Remove buttons to manage this list.

You should check the terms of your font license agreement before 
embedding any fonts. Named fonts will be embedded if they are refer-
enced in the original PostScript language file and are available to PDF 
Creator.

Base 14 fonts in this list are always embedded, even if the Embed base 14 
fonts check box is not selected. This allows you to include individual 
base 14 fonts in a document, rather than all base 14 fonts. 

Never embed

Fonts listed in this box are never embedded in the output PDF file. Use 
the Add and Remove buttons to manage this list.
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Embed all fonts (except base 14 fonts)

When this option is selected, all fonts present in the document (except 
base 14 fonts) are embedded in the output PDF file and all fonts that 
were embedded in the PostScript language file (by the printer driver or 
generating application) will also be embedded. If a font is referenced by 
the incoming PostScript file and is available to PDF Creator, it will be 
embedded in the generated PDF file.

If this option is not selected, the font will only be embedded if it is 
named in the Always embed list.

Any candidate for embedding is rejected if it is one of the base 14 fonts 
(unless it appears in the Always embed list), or it appears in the Never 
embed list.

Embed base 14 fonts

If this is selected, all base 14 fonts present in the document are embed-
ded in the output PDF file. Selecting this option implicitly adds the base 
14 fonts to the Always embed list.

Note that if you wish to embed individual base 14 fonts, rather than all
base 14 fonts, you should add them explicitly to the Always embed font 
list, and deselect this check box.

Subset fonts

With this option selected, only subsets of the original fonts are embed-
ded in the PDF file. This is the preferred setting, as it leads to smaller 
files. However, selecting Subset fonts prevents you from subsequently 
using Acrobat plug-ins or other tools that allow text editing within a 
PDF file, as not all characters from the embedded fonts are available for 
use.

5.6  Security tab

The options under the Security tab provide various levels of protection for 
your PDF documents. 
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Select the Encrypt PDF files check box to enable the other options in the tab.
Edition 3: July 2003 Jaws PDF Creator 35



Jaws PDF Creator on Macintosh platforms

36
Figure 5.10  Security tab

Encrypt PDF files

Select this option to encrypt the PDF files created by PDF Creator. 

This option is, as a default, not selected which means that users of the 
PDF have full access to the available options. When selected, the security 
options within this tab become available and thus restrictions can be 
placed upon the user of the PDF document.

The level of encryption depends on the selected PDF level, see 
Section 5.3 for more information. With PDF 1.3 you get 40-bit 
encryption. With PDF 1.4 you get 128-bit encryption.

5.6.1  Passwords

You can apply security to PDF files by entering passwords and restricting 
selected features, such as editing and printing in the Passwords section of the 
Security tab.
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A PDF file can have both an Open document password and a Change security 
password. If both passwords are applied, the document can be opened using 
either one.

When the correct Open document password is provided, the document is 
opened and decrypted. However, use of the document is limited by whatever 
restrictions have been specified in the Security options section of the dialog.

The Change security password allows the user to open the PDF and modify 
the security settings. When a file is opened with a Change security password, 
you have unrestricted access to the document, in effect, the security restric-
tions are temporarily disabled. If you wish to limit access to your file, you 
should apply a Change security password, otherwise anyone who opens the 
file is able to remove the restrictions.

It is important to note that the PDF viewing application will not prompt for a 
password if no Open document password is entered when creating a secured 
PDF. This means that when only a Change security password is used, the doc-
ument is opened without the user having to provide a password, and use of 
the file is limited by whatever security restrictions have been imposed. As a 
result, if the user only has the free version of Acrobat, they are never able to 
obtain unrestricted access to the document.

With Encrypt PDF Files selected, you can choose various options to define the 
level of user actions allowed.

It is important to note that the options available in the Security Options and 
Changes Allowed sections are different depending on whether you are creat-
ing PDF 1.3 or PDF 1.4 documents. When you are creating PDF 1.4 documents 
you have independent control over the Allow Content Access for the Visually
Impaired, Document Assembly and Fill in Forms and Signing options. When cre-
ating PDF 1.3 documents these options are automatically selected at the same 
time as the Allow Copying of Text or Graphics, General Editing and Comment 
Authoring options.
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5.6.2  Security Options

The Security Options section of the Security tab contains the following options:

Allow copying of text and graphics

With this option selected, the PDF user is able to copy and paste text and 
graphics from the file.

Allow content access for the visually impaired

With this option selected, the PDF user is able to configure various 
reader options such as custom text, background colors and create more 
visible color schemes.

Note: When generating PDF 1.3 files, the ...visually impaired option is dis-
abled and mimics the ...text or graphics option.

5.6.3  Changes Allowed

The options in the Changes Allowed section of the Security tab allow you to 
define the level of changes you will allow users to make on the PDF 
document.

No options selected

With no options selected, users are unable to do anything to the PDF 
document, including filling in signature and form fields.

Document Assembly

With this option selected, PDF users can insert, delete, and rotate pages, 
and create bookmarks and thumbnails.

General Editing

When this option is selected, the PDF user can perform Document 
Assembly and general editing, but cannot extract the contents of the 
PDF.

Fill in forms and signing

Allows the PDF users to sign and fill in forms, but not create them.

Comment Authoring

Allows the addition and editing of PDF (sticky note) comments and use 
of the highlight pen, but not general editing.
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Printing

Select either Enabled or Disabled to allow or disallow printing of the 
PDF file.

5.7  Advanced tab (Mac OS X only)

Note: On Classic Macintosh platforms, you can access advanced options by 
clicking Advanced in the General tab to open the Advanced Options dialog 
box. The options in this dialog box are the same as those in the Advanced tab 
on Mac OS X platforms, which are described below.

Figure 5.11  Advanced tab
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The Advanced tab contains the following options: 

Transfer functions

This menu provides the option of preserving, applying or removing 
transfer functions from the PostScript language file. If you select the 
Apply option, the document is displayed the same on-screen as when 
printed.

Convert CMYK to RGB

This option only applies to color images. If it is enabled, any four-color 
CMYK images in the PostScript language input file are converted to 
RGB images in the PDF output. This can result in a smaller PDF file that 
displays more quickly. You should enable this if your documents are 
intended for on-screen viewing, and disable it if they are intended for 
printing.

Enabling this option can cause an apparent color shift in the images to 
which it is applied. The conversion that PDF Creator uses is better suited 
to photographic images than to CMYK approximations of spot colors. 
You may find that on-screen reproduction of some graduated fills and 
tinted images is better with this option disabled than with it enabled.

Convert device independent colors to device dependent colors

With this option selected, PDF Creator converts colors specified in 
device-independent CIE-based color spaces into device-dependent RGB. 
This produces PDF files which display more quickly. Otherwise, these 
colors are converted into a device-independent calibrated RGB color 
space. This produces PDF files which render more slowly, but whose 
colors are more constant across properly set up output devices.

Preserve halftones

With this option selected, any halftone changes requested by the job are 
passed through to the PDF file. You should select this option when pro-
ducing PDF files for print, and disable it when producing PDF files for 
on-screen viewing.
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Preserve overprint

With this option selected, any changes to the PostScript graphics state 
overprint parameter requested by the job are passed though to the PDF 
file. This feature, along with Preserve OPI comments, Transfer functions, 
Under Color Removal and Black Generation Information is intended prima-
rily for use within a pre-press environment.

Preserve under color removal and black generation information

This option allows you to preserve or remove under-color removal and 
black-generation information from the PostScript language file. This is 
normally only used in pre-press environments.

Use %%BoundingBox for 

As well as the conventional page size request embedded in the 
PostScript language file, many files also contain comments describing 
the actual extent of marks on the page. The Use %%BoundingBox for
option lets you: ignore these comments—by selecting Nothing; use the 
bounding box for the PDF page size—by selecting Page Size; or use the 
bounding box for the optional page cropping box—by selecting Crop 
box.

Acrobat Reader always displays pages as if they were the size specified 
for the page cropping box. Some applications may generate their own 
cropping box information using pdfmark, which overrides any cropping 
box set in this way.

Preserve OPI comments

OPI (Open Prepress Interface) is used to reduce network traffic by sub-
stituting high-resolution images with low-resolution screen images for 
the purpose of screen display and page make-up.

With this option selected, OPI comments in the PostScript language 
input file are reproduced as OPI dictionaries in the PDF output. 

It is not necessary for the high-resolution image data to be available to 
PDF Creator—it passes the file name through to the output. PDF Creator 
produces only an OPI 1.3 dictionary, only an OPI 2 dictionary, or both, 
depending on whether the PostScript language file input uses one or 
both versions of the OPI comments.
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5.8  Reporting tab (Classic Mac only)

Note: On Mac OS X platforms, you can access reporting options by choosing 
Jaws Config Editor > Preferences. See Section 5.10 for more details.

The Reporting tab allows you to control what happens to messages generated 
by the PostScript language compatible interpreter.

Figure 5.12  Reporting tab

Display Messages

If this option is selected, PDF Creator displays all messages generated by 
the interpreter in an on-screen message box. 

This is useful for debugging. You should not leave this option perma-
nently enabled, as the PostScript printer drivers normally cause mes-
sages to be generated continuously—for a serial printer, this allows 
tracking of the job, but viewing each message individually can become 
quite tedious.
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Only log errors

If this option is selected, only error messages are written to the log file—
normal progress and user messages continue to be displayed (if that 
option has been selected), but are not written to the log file.

Discard messages

If this option is selected, all messages from the interpreter are discarded. 
This is of use in a batch environment. When enabled, this also causes all 
error messages to be discarded, so you should use it with caution.

Create individual log files for each job

If this option is selected, PDF Creator creates an individual log file for 
each job, and writes messages generated by that job to its log file. The 
log file is created in the same folder as the PDF file, and with the same 
name, but with a .log extension. It may be viewed with a text editor. If 
the messages are merely informative, the log file is created in addition to 
the PDF output file. If an error occurs, the PDF file is not created, and the 
log file contains the relevant error messages.

Log all messages to

If this option is selected, the messages generated by all jobs are collected 
in a single log file.

The location and name of the log file can be entered into the text box. 
Alternatively, use the browser to choose the location of the log file.

When you select this option, a Directory dialog box appears allowing 
you choose the required name and location.

5.9  About Jaws PDF Creator

The About Jaws PDF Creator splash screen displays useful information about 
your version of Jaws PDF Creator.

Mac OS X: To open the splash screen, choose the Jaws ToPDF > About 
ToPDF menu option or the Jaws Config Editor > About Config Editor
option.

Classic Mac: To open the splash screen, choose the About Jaws PDF 
Creator option from the Apple menu.
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The splash screen contains the following information:

Version

This is the version number of PDF Creator.

Kernel build

This is a unique identification of the version of PDF Creator that you are 
using, and should be included on all bug reports that you submit.

Serial No.

This is the Serial number you entered when installing the registered ver-
sion of PDF Creator. You need this if you wish to report bugs or other-
wise require support. If you installed a demonstration version of PDF 
Creator, this will read Evaluation version.

Enter Serial Number

This option is used to license your version of Jaws PDF Creator. For 
more information see Section 2.2.

5.10  Preferences (Mac OS X only)

With the Config Editor open, choose the Jaws Config Editor > Preferences menu 
option to access message handling options.

The Config Editor Preferences dialog box appears:

Figure 5.13  Config Editor Preferences
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Discard all messages

If this option is selected, all messages from the interpreter are discarded. 
This is of use in a batch environment. When enabled, this also causes all 
error messages to be discarded, so you should use it with caution.

Create individual log file for each job

If this option is selected, PDF Creator creates an individual log file for 
each job, and writes messages generated by that job to its log file. The 
log file is created in the same folder as the PDF file, and with the same 
name, but with a .log extension. It may be viewed with a text editor. If 
the messages are merely informative, the log file is created in addition to 
the PDF output file. If an error occurs, the PDF file is not created, and the 
log file contains the relevant error messages.

Append all messages to:

If this option is selected, the messages generated by all jobs are collected 
in a single log file.

The location and name of the log file can be entered into the text box. 
Alternatively, click Choose to browse to the location of the log file.

Only include interpreter error messages in log file

If this option is selected, only error messages are written to the log file—
normal progress and user messages continue to be displayed (if that 
option has been selected), but are not written to the log file.

5.11  Font management

To manage fonts, open the PDF Creator Config Editor (a.k.a. Control Panel) 
and choose the File > Manage Fonts option. Macintosh format fonts are 
supported.

The Font Management dialog allows you to control which fonts are installed 
and available to the PDF Creator printer. These fonts are always installed on 
your disk, of course, but you can control whether or not they are visible to 
PDF Creator, and therefore whether or not they can be loaded by the 
PostScript findfont operator.
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This option makes no distinction between PFB format, PFA format (an ASCII 
format for Type 1 fonts typically used on UNIX platforms), or raw PostScript 
files containing Type 3 fonts. All of these fonts are displayed as PostScript 
fonts in this dialog, and all may be successfully installed for use with PDF 
Creator.

The core fonts that are installed with PDF Creator cannot be removed and are 
indicated with a “lock” icon. The core font set includes clones of the 35 stan-
dard PostScript printer fonts, as well as stub files which refer to them. For 
example, Helvetica is one of the standard fonts, but the font file for Helvetica 
is just a stub that substitutes the clone font Helsinki instead.

The reasons for wanting to make the fonts visible to PDF Creator differ for the 
two formats. The principal reason for installing Type 1 fonts is if you are using 
Jaws ToPDF to convert files which do not contain embedded fonts—for 
example, if they were created on a different machine. If you try to convert 
such files without making the fonts available to PDF Creator, the document is 
converted with incorrect text metrics. By making the fonts you need available 
to PDF Creator, the document is converted with all the correct fonts and 
spacing.

If you add a Type 1 font to PDF Creator because it is used but not embedded 
in a PostScript language file, remember that it is not embedded in the PDF 
output files unless you also add it to the Always Embed list in the Font 
embedding tab. See Section 5.5 for more information.

Clicking the Select Folder button displays a browser dialog, allowing you to 
select the folder where PDF Creator can find the fonts you want to add. The 
System Fonts button is a shortcut, equivalent to opening the fonts folder.

5.12  Importing configurations

Note: This option is available on Mac OS X platforms only. 

You can use the Import configurations option to import an XML file, containing 
the PDF configuration(s) from another machine or user. To create such an 
import file, you must use the Export configurations option, described in 
Section 5.13. For example, this option can be used to ensure all users within an 
organization have the same configuration settings and therefore create PDF 
documents of the same type.
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To import an XML configuration file:

1. With Jaws Config Editor active, select Import Configuration from the File
menu.

2. Use the displayed browser to choose the XML file to be imported. The 
file will have a .xml extension.

3. Click Open to import the file.

4. Choose the configuration(s) you wish to import. Use the Command key 
to select multiple configurations. 

5. If you wish to make the configuration(s) available to other users, select 
the Make available to all users check box (requires administrator 
privileges).

6. Click Import.

Note: When an XML file is exported and subsequently imported, the Always 
output files to and Launch on job completion locations are not transferred. This 
is because these locations are system specific and may not be appropriate on 
your system.

5.13  Exporting configurations

Note: This option is available on Mac OS X platforms only. 

You can use the Export configurations option to export an XML file, containing 
details of your configuration(s), for use on another machine or by another 
person. This XML file can be transferred between Macintosh and Windows 
versions of Jaws PDF Creator. To import such an XML file, you must use the 
Import configurations option, described in Section 5.13. For example, this 
option can be used to ensure all users within an organization have the same 
configuration settings and therefore create PDF documents of the same type. 

Note: An XML file is a text file which can be opened and hand edited. 
However, doing this may cause your version of Jaws PDF Creator to produce 
unexpected results or fail.

To create an XML configuration file for distribution to other users of Jaws PDF 
Creator:

1. Ensure all your configurations are correct in all details.
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2. With Jaws Config Editor active, select Export Configuration from the File
menu.

3. Choose the configuration(s) you wish to export. Use the Command key 
to select multiple configurations.

4. Click Export.

5. Use the displayed browser to choose a location and name for your XML 
file. Ensure the file has a .xml extension.

6. Click Save to save the file.

Note: When an XML file is exported and subsequently imported the Always 
output files to and Execute on completion locations are not transferred. This is 
because these locations are system specific and may not be appropriate on 
your system.
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6  Support
This section offers support and troubleshooting advice.

6.1  Downloading PDF Creator

You are able to download further copies of PDF Creator from:

• www.jawspdf.com.

To download an installer you must either provide a valid serial number or 
legitimate e-mail information. 

Have the following information ready:

• Serial number (if you have one)

• Your name

• Job title

• Company name

• Telephone number

• E-mail address

• Platform on which PDF Creator is going to be used

• Language

6.2  Reporting problems

There is a FAQ section under the Support page at www.jawspdf.com.

If your problem is not covered here, you should submit a bug report.

When submitting a problem you should provide the following information:

• Operating system (For example, Classic Macintosh or Mac OS X)

• Version of PDF Creator

• Kernel build time (the kernel build time uniquely identifies the PDF 
Creator kernel you are using)
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• Class of problem (kills application/kills PDF Creator/kills Operating 
System/incorrect output)

• Detailed description of problem

• Contact details

The kernel build time is available in the About Jaws PDF Creator splash 
screen.

Mac OS X: To open the splash screen, choose the Jaws ToPDF > About 
ToPDF menu option.

Classic Mac: To open the splash screen, choose the About Jaws PDF 
Creator option from the Apple menu.

6.3  Registering PDF Creator

Jaws PDF Creator can be registered on the World Wide Web. Point your 
browser at www.jawspdf.com and select the Support page and fill in the form. 
You should have the following information ready:

• Your name

• Company name and address

• E-mail address

• Company size

• Where PDF Creator was purchased

• Number of copies purchased

• The serial number supplied with the software

6.4  Contact information

If you need to contact Global Graphics Software Limited directly for any 
reason, you can use the address and numbers below:

Global Graphics Software Limited

Barrington Hall

Barrington
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Cambridge, CB2 5RG

United Kingdom

Tel: +44 (0) 1223 873 800

Fax: +44 (0) 1223 873 873

Web site: www.jawspdf.com. 

Mail regarding PDF Creator can be sent to sales@jawspdf.com.

6.5  Troubleshooting

This section offers some troubleshooting advice:

Acrobat Reader displays text as bullets

This is normally a problem with Acrobat incorrectly calculating the size 
of text displayed when using an embedded TrueType font. In Acrobat 
Reader’s File > Preferences > General dialog, deselect the check box 
labelled Greek text below... pixels.

Acrobat Reader does not display some text

There are some undocumented restrictions on the commands which 
Acrobat Reader accepts in embedded CFF fonts (PDF Creator uses the 
CFF format for all embedded Type 1 fonts; you can find out the type of 
fonts used in your documents using the menu option File > Document 
Info > Fonts dialog in Acrobat Reader).

Where the PDF file produced by PDF Creator contains such unsup-
ported commands, Acrobat Reader displays some characters in the font 
concerned as blanks. Please submit a bug report if you find such a font.

Text which should be outlined is displayed as solid

This appears to be a problem with the way Acrobat Reader displays cer-
tain Type 3 fonts. The document prints to a PostScript language-compat-
ible printer correctly.
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Bitmaps which should be transparent mask the background color

Acrobat Reader sometimes has problems displaying large bitmap masks, 
displaying them as opaque images instead. Use the Acrobat Reader 
menu option File > Preferences > General to open the General Preferences 
dialog, and unselect the Smooth Text and Images check box.

Invalidaccess error with setdistillerparams

The setdistillerparams operator is the way that PDF settings are con-
trolled from within a PostScript language file. PDF Creator supports 
mostly the same set of parameters that other PDF creation applications 
support, although there are some extra parameters for PDF Creator 
(which are used by the PDF Creator Config Editor/Control Panel), as 
well as some parameters which do not make sense for PDF Creator.

You only ever see this message if you attempt to distill a PostScript lan-
guage file which explicitly requests LZW using the setdistillerparams
operator. If so, you should amend the PostScript language file to request 
Zip compression instead.

Colors in the PDF file do not match original colors

If you have enabled the Convert CMYK to RGB option (see the Advanced 
tab (Mac OS X only) or the Advanced Options dialog box (Classic Mac)),
you may find that the color reproduction of some images is compro-
mised. There is no universal way to convert CMYK images to RGB for 
on-screen viewing. The algorithm that PDF Creator uses for this conver-
sion has been tuned to work well with photographic images. This means 
that it may not work so well for tinted images or graduated fills where 
the CMYK color contains a large black component. If this happens, you 
should deselect the Convert CMYK to RGB option. This results in slightly 
larger PDF files, but should have no other side effects.

Rotation and applications and drivers that do not generate %%ViewingOrientation

For applications and drivers that do not generate 
%%ViewingOrientation DSC comments a new option, called 
PageOrientation, has been added to the printer driver. By default 
PageOrientation is switched off and the auto-rotate setting in the PDF 
Creator configuration is respected. There are four other options: “Rotate 
by 0 degrees”, “Rotate 90 degrees counter-clockwise”, “Rotate 90 
Jaws PDF Creator Edition 3: July 2003



6 Support
degrees clockwise” and “Rotate 180 degrees”. These four options all 
switch off auto-rotate (if it was enabled) and apply the specified rotation 
to the page. The page is rotated from its default orientation. Because dif-
ferent applications do different things when, for example, they are asked 
to generate a landscape page from a portrait page (and vice versa), some 
trial and error is required.
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Appendix A

ATechnical Information
A.1  How PDF Creator works
This section describes how PDF Creator works and how it integrates with the 
operating system. The information contained here is not essential for using 
PDF Creator however an understanding of the information will help you get 
the most out of the product.

PDF Creator is built around a complete PostScript language-compatible 
interpreter. In the case of PDF Creator, the interpreter is called Jaws and is a 
clone interpreter developed for incorporation into hardware and software 
products. Also the raster-based back-end of the interpreter has been replaced 
with code which outputs graphical primitives as text—in this case, the text 
builds up into PDF page descriptions. It is also possible to convert PostScript 
language files into other page description languages using the same approach.

The PostScript language-compatible Jaws interpreter allows a number of 
transformations to be carried out in the interpreter pipeline, which is how 
PDF Creator implements features such as TrueType font substitution.
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A.1.1  Integration with the operating system

On Mac OS X platforms, PDF Creator is implemented as a CUPS printer and 
backend. On Classic Macintosh platforms, PDF Creator implements a custom 
hose which allows a developer to process the PostScript language output from 
the LaserWriter driver version 8.6 or later in any way.

When the interpreter starts up—normally before every job is processed—it 
executes the file startup.ps. This file may contain any code that is to be exe-
cuted once for all jobs. You should only modify this file if you are capable of 
writing PostScript language code. It contains the default parameter sets used 
by the image compression filters, and the lists of TrueType fonts which require 
special handling by PDF Creator. For more information about the contents of 
startup.ps see Section A.2.4.1.

In addition, the PostScript language-compatible interpreter executes the file 
prologue.ps at the start of every job it converts. This file can contain any 
PostScript language code that needs to be run for every job. An example of 
this is the code that changes the contents of the document info dictionary in 
the PDF output file, described above. It also executes the file epilogue.ps at 
the end of every job. This may be used, for example, for any pdfmark calls that 
you may want to apply to every job you convert. See Section A.2.4.2 for more 
information on prologue.ps and Section A.2.4.3 for more on epilogue.ps.

A.2  Advanced topics
This section describes topics to do with file names and font embedding.

A.2.1  File names

PDF Creator has two strategies for creating the output file name, depending 
on whether you are using the PDF Creator printer or are converting files with 
Jaws ToPDF.

When you are printing directly to PDF Creator from an application, the docu-
ment name passed to it by the printing system is used as a starting point from 
which to generate the name of the PDF output file.

If the document ends with a recognized suffix (.ps or .eps) it is removed 
before .pdf is appended.
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This is the file name which PDF Creator offers you in the Save dialog box it 
normally displays for every job.

The output folder is determined by considering the following options:

• The folder specified by the Always output files to option in the General 
tab in the PDF Creator Config Editor/Control Panel, if selected.

• The last folder to which PDF Creator wrote a PDF file.

Unless the Always output files to option is selected, PDF Creator always pro-
vides you with the opportunity to change both the folder and the file name 
using a browser dialog.

At times, you may be surprised at the file names that PDF Creator generates in 
this way. The reason for this is that the document name is not normally used 
by the printing system, except in dialogs, to provide information about the 
status of the job. This means that there is no official format for the document 
name, and most applications make up their own rules.

Therefore, PDF Creator may offer a default file name that is different to that 
which was expected. However, the file name that PDF Creator generates is 
always legal. 

Note: The colon (:) is the only character that is not valid in a Macintosh file 
name.

PDF Creator never overwrites an existing output file without prompting, 
unless the Overwrite an existing PDF file option in the General tab of the Config 
Editor/Control Panel is selected.

If you have selected Always output files to from the General tab and a file with 
the same name already exists, PDF Creator appends a unique number to the 
file name.

When you use Jaws ToPDF to convert existing files, PDF Creator uses the 
input file name instead of the document name (because there is no document 
name) as the basis for the output file name. PDF Creator uses the name and 
location of the input file as the default destination, except that the file exten-
sion is replaced by .pdf. If Always output files to is selected from the General 
tab, the file is saved in this location. If not, PDF Creator displays the browser 
dialog and allows you to change the output file name.
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See Section 5.3 for more information on the General tab.

A.2.2  Font embedding

PDF files are capable of containing fonts in three different formats. PDF 
Creator is able to handle all three. Jaws PDF Creator only ever embeds fonts 
that were embedded in the original PostScript language file. Fonts that were 
read from disk, including the base 14 PDF fonts (but not including TrueType 
fonts read as part of the substitution process described below), are not embed-
ded unless they are selected for embedding. See Section 5.5 for more 
information.

A.2.2.1  Type 1 fonts

Type 1 fonts are the traditional format for hinted fonts in the PostScript lan-
guage community. Type 1 fonts are always handled in a standard way by 
printer drivers, and PDF Creator can always extract them from the document 
and embed them in the PDF file. PDF Creator always converts Type 1 fonts to 
the new CFF (Compact Font Format), which is a more compact way of encod-
ing the same information. Version 3 of Acrobat supports both the original 
Type 1 format and the Compact Font Format; however, there are some undoc-
umented restrictions in the CFF commands that Acrobat Reader understands. 
For this reason, you may sometimes find that PDF Creator embeds a Type 1 
font which will not display correctly on screen, but which does print correctly 
from Acrobat to a PostScript language compatible printer. If you encounter 
such a font, you should submit a PDF Creator bug report, which will enable us 
to comply better with the undocumented restrictions.

A.2.2.2  Type 3 fonts

Type 3 fonts are the format used in the PostScript language community for 
unhinted fonts (such as complex logotypes and bitmap fonts). PDF Creator 
does support Type 3 fonts, and will embed them.
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A.2.2.3  TrueType fonts

TrueType is an alternative format for hinted fonts, which originally evolved in 
the personal computer community, rather than the PostScript language 
community. Many modern PostScript language compatible interpreters 
(including PDF Creator) are able to handle TrueType fonts directly, but for his-
torical reasons, PostScript printer drivers make life more difficult.

The following paragraphs describe how the various PostScript printer drivers 
handle TrueType fonts, and how PDF Creator’s TrueType font substitution 
works with each of them.

TrueType fonts with the Mac OS LaserWriter driver

These are the easiest to handle. The Mac OS printer driver embeds TrueType 
fonts in the PostScript language file as Type 42 PostScript fonts. PDF Creator 
can handle these directly and embed the font in the PDF output file. This hap-
pens regardless of whether TrueType substitution is on or off. 

A.2.3  PostScript ProcSet resources

Fonts are one kind of resource that the PostScript printer driver may embed in 
a PostScript language file. Procedure sets, or ProcSets are another. Typically, 
both the printer driver and the application itself can generate ProcSets, which 
are used to define PostScript language procedures which are frequently used 
by the document. These ProcSets are identified by comments within the 
PostScript language file.

The convention used for these identifying comments allows a printer driver to 
omit a resource from a file when it is first generated, and subsequently 
arrange either for the printer to read the resource off disk, or for the spooler to 
insert the resource into the job immediately before sending it to the printer.

Control over application-generated ProcSets is left to the individual 
applications, and may not be possible.
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You can instruct PDF Creator to intercept ProcSet resources in files sent to it, 
and save them to disk for later use. This option is not accessible from the PDF 
Creator Config Editor/Control Panel. Instead, you must find the following 
lines in the file prologue.ps (see Section A.2.4 for details):

%%%%%
% Here's how to turn on Resource Capturing.Uncomment the next line
%systemdict /NiknakDict get begin /ExtractResources true def end

To enable saving of ProcSet resources to disk, uncomment the line by remov-
ing the % character from the beginning of the line. Once the ProcSets have been 
saved to disk, you are able to send jobs with the ProcSet resources omitted to 
PDF Creator, and have them processed properly. If PDF Creator detects that a 
job requires a ProcSet resource that has not been saved to disk it issues a warn-
ing message to that effect, although the job will probably fail with a PostScript 
language error. 

PostScript ProcSet resources normally have a version number as well as a 
name; PDF Creator treats ProcSets with the same name but different version 
numbers as being completely different.

When using this feature, you should bear in mind that ProcSets are PostScript 
language code and usually subject to copyright restrictions. Saving the 
resources to disk is equivalent to permanently downloading them to a 
printer—the authors of your application may or may not have granted you 
permission to do this.

You should only make use of this feature if you are working in a controlled 
environment and you are already comfortable with the idea of ProcSet 
resources.

A.2.4  Custom PostScript language files

There are three PostScript language files that are executed by the interpreter:

• startup.ps

• prologue.ps

• epilogue.ps
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These files are in the following location:

Mac OS X: /Library/Applications/Support/Jaws PDF Creator/Jaws-
Folders/default/

Classic Mac: Jaws PDF Creator:Jaws PDF Creator 
Resources:Default:

You can use these files for any custom PostScript language code that you want 
to be executed. Needless to say, you should only modify these files if you are 
comfortable with writing PostScript language code.

A.2.4.1  startup.ps

This file is executed when the interpreter first starts up. You can use it to make 
any global changes. In particular, the parameters that PDF Creator uses for the 
JPEG and CCITT image compression filters are stored here, as well as the lists 
of TrueType fonts that need special handling by the TrueType substitution 
code.

The image compression parameters are stored in four PostScript dictionaries 
at the start of the file, which give the parameters for the JPEG low, medium 
and high compression filters, and the CCITT fax compression filter 
respectively. If you understand how the PostScript compression filters work, 
you can modify the parameters here to change the behavior of the filters. The 
most common example might be to change the Q factor for one or more of the 
JPEG filters.

The TrueType dictionaries are stored near the end of the file, and are initially 
empty. You can add the names of any fonts that you have determined require 
special handling by the TrueType substitution code. For more information on 
the format of these dictionaries see Section A.2.2, “Font embedding”.

A.2.4.2  prologue.ps

This file is executed by the interpreter at the start of each job. This gives you 
the opportunity to make any changes that you want to apply on a per-job 
basis. 
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There are three pieces of example code here that you can use directly. The first 
section of code enables collection of PostScript ProcSet resources. The line:

systemdict /NiknakDict get begin /ExtractResources true def end

turns on the collection of resources from incoming PostScript language jobs. 
After installation, this line is commented out—the % at the start of a line intro-
duces a PostScript language comment. To enable collection of ProcSet 
resources, uncomment the line by removing the %, using a text editor. When 
you have collected all the ProcSet resources you need, you should comment 
out this line again.

The code to override the default author and creator information is also located 
here (normally extracted directly from the PostScript language file being 
converted). The code for each field is similar.

The PostScript procedure DoAuthor changes the author name:

(: YourNameHere) DoAuthor

This causes YourNameHere to appear as the author of the document. DoAuthor
works by mangling the %%Author comment present in the job, which is why 
the operand to DoAuthor must start with a colon and space before the name 
itself.

The PostScript procedure DoCreator changes the creator in the same way:
(: CreatorName) DoCreator

After installation, the example lines for DoAuthor and DoCreator in 
prologue.ps are both commented out. If you wish to change the author or cre-
ator information, you must uncomment these lines by removing the initial %
as well as changing the strings to reflect the names that you want.

A.2.4.3  epilogue.ps

This file is executed by the interpreter at the end of each successful job. Any 
PostScript language code placed here is included in the PDF file (if it generates 
any pages of output). More importantly, you may wish to place any calls to 
pdfmark here that you want to be applied to all jobs you convert.
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A.2.5  Using PostScript plugins

Jaws PDF Creator has the ability to dynamically load PostScript language 
plugins. PostScript language plugins can be used to implement extra features. 
For example, we have supplied the following plugins:

• XPressTrim.jcp - an idiom set that catches crop marks in QuarkXPress 
jobs and adds a TrimBox to the page. 

• CorelTrim.jcp - an idiom set that catches crop marks in CorelDraw jobs 
and adds a TrimBox to the page.

• ConfigRecorder.jcp - adds a text annotation to the first page of the job, 
recording the Jaws PDF Creator configuration used to make the PDF 
file.

These plugins are stored in the Plugins (inactive folder), see Section A.3.2 
for further details. To use a plugin, you must copy the relevant .jcp file into 
the default folder.

Please see the www.jawspdf.com website for the latest list of available 
plugins.

You can also create your own PostScript plugins. All such plugins should be 
given a .jcp extension. We recommend you place your PostScript plugins in 
the Plugins (inactive) folder. Any plugins you wish to make active should 
be manually copied into the default folder, in the same way as the supplied 
plugins.

The plugins are executed alphabetically, and if a particular plugin fails, the 
remaining plugins will still be executed. All actions can be viewed in the Jaws 
PDF Creator log file.

Visit www.jawspdf.com for information on new plugins for Jaws PDF Creator.

If you have questions, contact creator-support@jawspdf.com.

A.3  Map of installed files
The following tables list all the folders and files placed on your disk when you 
install PDF Creator.
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A.3.1  Macintosh installation files

The following folders and files are installed on Mac OS X platforms:

Jaws PDF Creator/

The default installation folder. This folder is created in the Applications
folder, unless you choose a different location in the Installer.

ToPDF

The PostScript language to PDF conversion utility.

Config Editor

The Configuration Editor. See Section 5 for details.

Read Me

A SimpleText file containing important user information.

Jaws PDF Creator Manual.pdf

Manual in Acrobat PDF format.

The following folders and files are installed on Classic Macintosh platforms:

Jaws PDF Creator:

The default installation folder. This folder is created in Applications
folder, unless you choose a different location in the Installer.

Jaws ToPDF

The PostScript language to PDF conversion utility.

Read Me

A SimpleText file containing important user information.

Make Jaws PDF Creator

A small application that creates the PDF Creator Desktop Printer that is 
necessary for printing from any application. Since a Desktop Printer is 
automatically created by the installer, you should not normally need to 
use this application.

Jaws PDF Creator Manual.pdf

Manual in Acrobat PDF format.
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Scripts:

Folder containing two scripts: one for Eudora and one for Outlook 
Express. For more information see “Launch on job completion” on 
page 28.

Jaws PDF Creator Resources:

This folder contains the following items that are required by PDF 
Creator.

Jaws PDF Creator File App

A small application that prompts you to enter a PDF file name. This is 
used by PDF Creator during the conversion process.

Default

See “General files used by all operating systems”.

Font

See “General files used by all operating systems”.

Resource

See “General files used by all operating systems”.

Plugins (active)

See “General files used by all operating systems”.

JAWS PDF CREATOR RESOURCES (Mac OS X only):

/Library/Printers/PPD Plugins/Jaws PDF Creator PDE.plugin

Implements the Jaws PDF Creator pane in the Print dialog (Print Dialog 
Extension).

/Library/Printers/PPDs/Contents/Resources/en.lproj

The PostScript Printer Description file, it defines the capabilities of the 
PDF Creator printer.

/Library/Application Support/Jaws PDF Creator/PostProcessingApp

A helper application used to support post processing of PDFs.
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/Library/Preferences/ or ~/Library/Preferences/

Configurations and user settings are saved in preferences files. These are 
located in /Library/Preferences/ if global, or ~/Library/Preferences
if user-specific.

/usr/libexec/cups/filter/jawspdfcreator

The CUPS printer which converts the PostScript file to a PDF file.

/usr/libexec/cups/backend/jawsbackend

The application which writes the PDF to disk.

/Library/Application/Support/Jaws PDF Creator/JawsFolders/

This folder contains the following items that are required by PDF 
Creator.

default

See “General files used by all operating systems”.

fonts

See “General files used by all operating systems”.

resources

See “General files used by all operating systems”.

plugins (active)

See “General files used by all operating systems”.

lib

This folder contains library files that are required by Jaws PDF Creator.

SYSTEM FOLDER ITEMS (Classic Mac only)

Control Panels

Jaws PDF Creator. The Jaws PDF Creator Control Panel.

Preferences:Jaws PDF Creator Preferences

This file contains all of your PDF Creator Preferences and 
configurations.

Extensions:Printing Plug-ins:Jaws PDF Creator:

The core PDF Creator PostScript language to PDF converter library.
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Extensions:

Folder containing the following components of the Apple LaserWriter 
driver v8.6.

LaserWriter 8

The Apple LaserWriter 8.6 PostScript Printer driver.

PrintingLib

A shared library required by the LaserWriter driver.

Printer Descriptions:Jaws PDF Creator PPD

The PostScript Printer Description file, used by the LaserWriter driver, it 
defines the capabilities of the PDF Creator printer.

A.3.2  General files used by all operating systems
epilogue.ps

A PostScript language file run after every job (see Section A.2.4.3).

prologue.ps

A PostScript language file used to configure PDF Creator (see 
Section A.2.4.2).

startup.ps

A PostScript language file run at startup, contains compression settings 
(see Section A.2.4.1).

Default:

A folder PDF Creator uses for miscellaneous files.

Font(s):

The folder PDF Creator uses for the 35 resident fonts.

The data in these files is copyright Stream Technologies Inc., and is not 
licensed for use with any software other than PDF Creator.

Resource(s):

This folder contains all the PostScript resources (other than fonts) that 
are known to the interpreter, and which may be loaded by the 
findresource operator.
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Plugins (inactive):

This folder contains some PostScript language plugins which can be 
used to implement extra features. See Section A.2.5 for further details.
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